
Introducing 

Windows 7
Microsoft Windows 7 is an operating system, a computer program that controls the op-

eration of your computer and the programs you run on it. Programs, also known as 

 applications, help you accomplish specifi c tasks, such as sending and receiving electronic 

mail and managing fi les on your computer. When you work with Windows 7, you will no-

tice icons and thumbnails, which are small pictures on your screen intended to be mean-

ingful symbols of the items they represent. You will also notice windows (thus the name 

of the operating system), which are rectangular frames on your screen that can contain 

icons, the contents of a fi le, or other usable data. A file is a collection of information that 

has a unique name, distinguishing it from other fi les. This use of icons, thumbnails, and 

windows is called a graphical user interface (GUI, pronounced “gooey”), meaning that 

you interact (“interface”) with the computer through the use of graphics. Windows 7 pro-

vides two distinct GUI experiences: a “basic” experience for entry-level systems and a more 

visually dynamic experience called Windows Aero for high-level systems. Windows Aero 

provides expanded visual effects, such as glasslike interface elements that you can see 

through, subtle window animations, window colors, and live thumbnails that you can 

 display on the taskbar.  In this unit, you will be introduced to basic Windows skills.

UNIT

A
Windows 7

No fi les needed.

Files You 
Will Need:

Start Windows and view the desktop

Use pointing devices

Use the Start button

Use the taskbar

Work with windows

Use menus, toolbars, and panes

Use dialog boxes

Use Windows Help and Support

Shut down the computer

OBJECTIVES
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UNIT

A
Windows 7

Starting Windows and 
Viewing the Desktop
When you fi rst start Windows 7, you see the Welcome screen, a way to identify yourself on the computer, or 
log on. After you log on, you see the Windows desktop, as shown in Figure A-1. The desktop is the graphical 
background on screen that represents a desk. It contains windows, icons, fi les, and programs, which you can 
use to access, store, organize, modify, and share information. The horizontal bar at the bottom of your screen 
is called the taskbar; it allows you to start programs and switch among currently running programs. At the 
left end of the taskbar is the Start button, which you use to start programs, fi nd and open fi les, access 
Windows Help and Support, and much more. Next to the Start button are taskbar-pinned programs, which 
you use to quickly start your Internet browser, Windows Explorer, and Windows Media Player. At the right end 
of the taskbar is the notifi cation area (also known as the system tray), which displays the program-related 
icons, time and date, and the Show the desktop button (the blank button next to the time and date). If 
you upgraded your computer to Windows 7 from a previous version of Windows, your desktop might contain 
additional desktop icons, toolbars, and other elements, such as miniprograms called gadgets. Gadgets pro-
vide easy access to frequently used tools and information, such as news headlines.  Windows 7 auto-
matically starts when you turn on your computer. If your computer is not on, you turn it on now.

1. Turn on your computer and wait for Windows to start
Windows automatically starts and displays a security prompt, the Welcome screen, or the desktop. The secu-
rity prompt provides an additional step to prevent unauthorized users from accessing your computer. If the 
security feature is turned on, Windows 7 asks you to press several keys at the same time to continue. If the 
security prompt appears, continue to Step 2; if the Welcome screen appears, skip to Step 3; and if the desk-
top appears, skip to Step 4.

2. If prompted on the screen, press and hold [Ctrl] and [Alt] with one hand, then press 
[Del] with the other to display the Welcome screen
At the Welcome screen, you select your username and enter a password to identify yourself on the com-
puter. If you share the computer with other users, you see multiple usernames on the Welcome screen.

3. In the Welcome screen, click your username, if necessary, type your password, then 
press [Enter]
A password prevents other users from accessing your computer fi les without proper authorization. Win-
dows passwords are case sensitive, which means that Windows makes a distinction between upper- and 
lowercase letters and nonalphabetic characters (numbers and symbols). Only bullets appear as you type the 
password. This helps to prevent other people from learning your password. Once the password is accepted, 
the Windows desktop appears on your screen, as shown in Figure A-1.

4. If a message pops up in the notifi cation area, as shown in Figure A-1, click the 
Close button  in the upper-right corner of the pop-up to dismiss it
A pop-up notification is an informational message that appears when you need it. For example, when 
Windows 7 detects the need for updates on your computer, a pop-up notifi cation appears, letting you know. 
If you don’t dismiss a notifi cation, it will fade away on its own. When you start Windows 7 for the fi rst time, 
the Getting Started window appears, displaying icons for easy access to common options, such as Go online 
to fi nd out what’s new in Windows 7, Personalize Windows, and Transfer fi les and settings from another 
computer, to help you get started using Windows 7.

5.   If the Getting Started window appears, click the Close button  in the upper-right 
corner of the Getting Started window
The Getting Started window closes. 

STEPS

If you are new to 
using the mouse, 
read through the 
next topic, “Using 
Pointing Devices.”

TROUBLE

To open the Getting 
Started window 
later, click the Start 
button, point to All 
Programs, click 
 Accessories, then 
click Getting Started.

QUICK TIP
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FIGURE A-1: Windows 7 desktop

Using and changing a password

You can set up your computer to require users to log on with a user-
name and password to use it. You specify a username and password 
when you install Windows 7, or an instructor or technical support 
person (the person in charge of computers at your school or busi-
ness) assigns you a username and password on a computer owned 
by the school or business. If you own your own computer and you 
want to change your password, or if you don’t have one and want 
to set one up, click the Start button, then click Control Panel. This 
opens the Control Panel window. Click User Accounts and Family 
Safety, then click Change your Windows password. The window 
changes to display the heading “Make changes to your user ac-
count.” Click Change your password or Create a password for your 
account, then follow the instructions provided. If you have forgotten 

your password, you can click Reset password on the Welcome screen 
to start the Forgotten Password Wizard. The Forgotten Password 
Wizard takes you step-by-step through a series of instructional win-
dows to help you recover user account information (username and 
password) and personalized computer settings. To use the Forgotten 
Reset Wizard, you need to insert a password reset disk into a disk 
drive or USB drive. To create a password reset disk, return to the 
Make changes to your user account window in the Control Panel, 
then click Create a password reset disk in the left pane in the win-
dow. Follow the instructions provided. Never write down your pass-
word on paper or let someone look over your shoulder as you log on 
to the computer. Always be sure to log off or shut down when you 
walk away from your computer.
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UNIT

A
Windows 7

Using Pointing Devices
A pointing device is hardware connected to or built into the computer you use to position the pointer, 
the small symbol on the screen that indicates the pointer’s position. The most common pointing devices 
are a mouse, as shown in Figure A-2, for desktop computers and a touch pad for laptop or notebook 
computers. When you move the mouse across a fl at surface (such as a desk or a mouse pad), or place your 
fi nger on the touch pad and drag across it, the pointer on the screen moves in the same direction. The 
shape of the pointer changes to indicate different activities. Table A-1 shows some common pointer shapes. 
Once you move the pointer to a desired position on the screen, you use the buttons on the mouse or 
touch pad to “tell” your computer what you want it to do. If your mouse has a scroll wheel between the 
two buttons, you can roll the wheel backward (toward you) or forward (away from you) to scroll through 
windows. Other available pointing devices include trackballs, which function similarly to the mouse, and 
stylus pens, which work with a tablet pad to move the pointer and enter handwritten information. You 
want to use the mouse to become familiar with these navigational skills. The steps in this lesson refer to a 
mouse; if you have another pointing device, use it instead.

1. Place your hand on the mouse, locate the pointer  on the desktop, then move the 
mouse back and forth across your desktop
As you move the mouse, the mouse pointer moves correspondingly.

2. Move the mouse to position the pointer over any icon in the notifi cation area
Positioning the mouse pointer over an icon or over any specifi c item on the screen is called pointing. 
When you point to an item, Windows often displays a ScreenTip, identifying the item or displaying status 
information, as shown in Figure A-3.

3. Locate the Recycle Bin on the desktop (the default position for this icon is in the upper-
left corner of the screen), position the pointer over it, then press and release the left 
mouse button
The act of pressing a mouse button once and releasing it is called clicking. The icon is now highlighted, or 
shaded differently from the other icons. The act of clicking an item, such as an icon, indicates that you have 
selected it. To perform an operation on an icon, such as moving it, you must fi rst select it.

4. Point to the Recycle Bin, press and hold down the left mouse button, move the pointer 
to the center of the desktop, then release the mouse button
The icon moves with the mouse pointer. This is called dragging, which you use to move Windows ele-
ments. If the icon jumps a little when you release the mouse, the desktop is set to align icons automatically 
with an invisible grid.

5. Point to the Recycle Bin, then press and release the right mouse button
Clicking the right mouse button is known as right-clicking. Right-clicking an item displays a shortcut 
menu, shown in Figure A-4. Shortcut menus display the commands most commonly used for the item you 
clicked. When a step tells you to “click,” it means to click the left mouse button. If you are supposed to click 
the right mouse button, the step will instruct you to “right-click.”

6. Click anywhere outside the menu to close the shortcut menu without choosing a command
7. Drag the Recycle Bin back to its original position on the desktop
8. Point to the Recycle Bin, then click the left mouse button twice quickly

The Recycle Bin window opens. It might be empty or it might contain fi le icons that you or someone else 
wants to delete. (You’ll learn more about the Recycle Bin in Unit C.) Clicking the mouse button twice in a row 
is known as double-clicking, and it allows you to open a window, program, or fi le that an icon represents.

9. Click the Close button  in the upper-right corner of the window to close it

STEPS

You can also press 
[Esc] to close a short-
cut menu without 
executing a 
command.

QUICK TIP

If the pointer 
changed to a point-
ing fi nger when you 
pointed to the Re-
cycle Bin and a win-
dow opened when 
you clicked it, your 
system is set up in 
Web style. See the 
Clues to Use box in 
this lesson for more 
information.

TROUBLE

If the icon jumps 
back to the left edge 
of the screen, Auto 
arrange icons is 
turned on. Position 
the pointer any-
where on the desk-
top, press the right 
mouse button, point 
to View on the menu 
that appears, then 
click Auto arrange 
icons to deselect it.

TROUBLE
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FIGURE A-3: ScreenTip in notifi cation area

Using the mouse with the Web style

In the default setup for Windows, you click an item to select it, and 
you double-click an item to open it. However, as you probably are 
aware, when you use Web sites on the Internet, you don’t need to 
double-click items to open them; you point to them, the pointer 
changes to , and you click once. You can choose whether you 
want to extend the way you click while using the Internet to the 
rest of the work you do on your computer so that you single-click 
icons to open items. This is known as Internet or Web style; 

 double-clicking to open icons is known as Classic style. To change 
from one style to the other, click the Start button on the taskbar, 
click Control Panel, click Appearance and Personalization, click 
Specify single- or double-click to open, click the Single-click to open 
an item (point to select), or Double-click to open an item (single-
click to select) option button, then click OK. Windows 7 is set by 
default to double-click to open items, and the steps in this book 
 assume you are using this setting.

Selected icon

Active items

appear black in

your Recycle

Bin menu;

inactive ones

appear gray

Commands

displayed by

right-clicking

FIGURE A-4: Shortcut menu

TABLE A-1: Common mouse pointer shapes

   Select items, choose commands, start programs, and work with programs

  Position the mouse pointer for editing or inserting text; called the insertion point or cursor

  Indicate Windows is busy processing a command

     Position the mouse pointer on the edge of a window to change its size 

  Position the mouse pointer to select and open Web-based content

shape  used to

Scroll wheel Right mouse

button

Left mouse

button

FIGURE A-2: Typical mouse
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UNIT

A
Windows 7

Using the Start Button
The key to getting started with the Windows desktop is learning how to use the Start button  on the 
taskbar. Clicking the Start button on the taskbar displays the Start menu, a list of commands that allows 
you to start a program, open a document, change a Windows setting, fi nd a fi le, or display support infor-
mation. Table A-2 describes the available commands on the Start menu that are installed with Windows 7. 
As you install more programs on your computer, fi nding them on the Start menu can sometimes be diffi -
cult. Windows 7 allows you to search the Start menu to fi nd installed programs and other Windows items, 
such as Control Panel programs, documents, music, Web sites you have visited, contacts, e-mail messages, 
and appointments. To search the Start menu, click in the Search box on the Start menu, and then start 
typing the search text you want. As you type, the Start menu fi lters out items to show you possible results, 
with priority given to the programs you use frequently. As you become more familiar with Windows, you 
might want to customize the Start menu to include additional items that you use most often.  You 
want to view the Start menu, perform a Start menu search, and open the Control Panel, a window 
 containing various programs that allow you to specify how your computer looks and performs.

1. Click the Start button  on the taskbar
The Start menu opens, as shown in Figure A-5. The left column of the Start menu is separated into two lists: 
pinned items above the separator line and most frequently used items below. The pinned items remain on 
the Start menu, like a piece of paper held by a push pin on a bulletin board, until you remove them. The 
most frequently used items change as you use programs: Windows keeps track of the programs you use and 
displays them on the Start menu for easy access. When a program or Windows item, such as Getting Started, 
appears on the Start menu with an arrow, the submenu displays a list of recently opened fi les for the pro-
gram known as a jump list for easy access. The top of the right column in the Start menu indicates the 
name of the person currently logged on to the computer. Below the username are commands that provide 
easy access to folders, Windows settings, Help information, and search functionality.

2. Point to All Programs
The All Programs submenu opens on top of the left column on the Start menu. An arrow next to a menu item 
indicates a cascading menu or submenu, which is a list of commands for that menu item. Pointing at 
these menu items displays another list from which you can choose additional commands. The All Programs 
submenu provides you access to common programs and accessories that come installed with Windows 7.

3. Click Back in the left column on the Start menu
The All Programs submenu closes and the original left column of the Start menu reappears. If you fi nd it 
diffi cult to locate a program or Windows item, you can use the Search box on the Start menu to help you 
fi nd it.

4. Click in the Search box at the bottom of the left column on the Start menu, 
then type control
As you type, the Start menu fi lters out items to show you possible results, with priority given to the pro-
grams you use frequently. The search results continue to narrow as you type your topic. If you don’t fi nd 
what you are looking for during a search, you can click “See more results” on the Start menu to display 
Windows 7 search results or expand the search to other areas, or click the Close button in the Search box to 
cancel the search.

5. In the Search box, click the Close button 
The Start menu reappears.

6. In the right column, click Control Panel
The Control Panel window opens, containing categories and icons for various programs that allow you to 
specify how your computer looks and performs.

STEPS

To add or remove a 
program from the 
pinned items list, 
right-click the pro-
gram on the Start 
menu, then click Pin 
to Start Menu or 
Unpin from Start 
Menu. To remove a 
program from the 
Start menu, right-
click the program on 
the Start menu, then 
click Remove from 
this list.

QUICK TIP

To pin an item on 
the Start menu, click 
the item on the Start 
menu, then drag it 
to a new location at 
the top. A black hori-
zontal bar indicates 
the new location.

QUICK TIP
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FIGURE A-5: Start menu

TABLE A-2: Start menu commands 

Specific Program Opens a specifi c program or submenu; displays pinned and frequently used items on the Start menu

All Programs Opens a list of all the programs installed on your computer

Search box Searches the Start menu for installed programs and other Windows items

Username Opens the personal folder for the current user, where you store personal folders, such as Contacts, Desktop, 
 Downloads, and Favorites

Documents Opens the Documents folder, where you store and manage fi les

Pictures Opens the Pictures folder, where you store and manage photos, images, and graphic fi les

Music Opens the Music folder, where you store and manage sound and audio fi les

Games Opens the Games folder, where you start and play games, such as Hearts and Minesweeper

Computer Opens the Computer window, where you access information about disk drives and other hardware devices

Control Panel Provides options to customize the appearance and functionality of the computer

Devices and Printers Opens the Devices and Printers window, where you can display and manage currently installed devices, such 
 as monitors, printers, and faxes, and add new devices 

Default Programs Opens the Default Programs window, where you set default programs and computer defaults and associate a 
 fi le type with a program

Help and Support Displays Windows Help topics, tutorials, troubleshooting, support options, and tools

Power button (Shut down) Exits Windows and turns off the computer

Arrow next to  Provides commands to switch users, log off from the computer, lock the computer, restart the computer, or 
Power button  set the computer in sleep or hibernate mode

command description
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UNIT

A
Windows 7

Using the Taskbar
The taskbar is the horizontal bar at the bottom of the desktop. The taskbar includes the Start button on the 
left end, program buttons and open window buttons in the middle, and the notifi cation area on the right 
end. The taskbar allows you to start programs and switch among currently running programs and open 
windows. When you start a program or open a window, a corresponding button appears on the taskbar. If 
the taskbar becomes too crowded with buttons for open windows, then buttons associated with the same 
program automatically group together into a single button to conserve space. When you rest the pointer 
over a taskbar button, Windows Aero displays a live thumbnail, showing the content of that window. 
Windows Aero provides two other ways to manage windows: Windows Flip 3D and Windows Flip. 
Windows Flip 3D creates a view of open windows in a three-dimensional stack on your desktop. Windows 
Flip allows you to fl ip through open windows (by using [Alt][Tab]), providing a live thumbnail of each 
window.  You want to use the taskbar to open and switch between windows.

1. With the Control Panel window still open, point to the Windows Explorer button  on 
the taskbar
A ScreenTip appears, displaying the name of the item. This ScreenTip indicates the item is not opened or 
started. Similar to the Start menu, the taskbar allows you to pin items (to the right of the Start button) to it for 
easy access. The pinned items remain on the taskbar until you remove them. By default, the pinned items on 
the taskbar include Internet Explorer, Windows Explorer, and Windows Media Player; your items might differ.

2. Click the Windows Explorer button on the taskbar
The Windows Explorer window opens in front of the Control Panel window. The Windows Explorer win-
dow allows you to navigate to different locations on your computer and manage files. The Windows 
Explorer window is now active, which means that any actions you perform take place in this window. The 
taskbar button for the active window (in this case, the Windows Explorer button) is also highlighted.

3. Point to the Control Panel button on the taskbar
For Windows Aero, a live thumbnail appears, displaying a miniature version of the Control Panel window, 
as shown in Figure A-6. When you point to the thumbnail, a Close button appears in the thumbnail and the 
window temporarily appears on the screen.

4. Click the Control Panel button on the taskbar
The Control Panel window moves in front of the Windows Explorer window. The Control Panel window is 
now active.

5. Press and hold  with one hand, then press [Tab], but do not release 
Windows Flip 3D displays the windows in a stacked format. The window that is currently active—the 
 Control Panel—appears in the front of the stack.

6. Still holding down , press [Tab] again
The Windows Explorer window appears in the front of the stack, as shown in Figure A-7, while the Control 
Panel window moves to the back.

7. Release 
The Windows Explorer window is now active.

8. Press and hold [Alt] with one hand, then press [Tab], but do not release [Alt]
Windows Flip displays a pop-up window with button icons for the open windows, including the desktop.

9. Release both keys simultaneously
The Control Panel window is now active. As you continue to press [Tab], Windows Flip cycles through the icons. 
In Windows Aero, the selected window appears with the other windows transparent. To display the window 
represented by the currently selected thumbnail, release both keys. The Control Panel window is now active.

STEPS

To pin a program to 
the taskbar, right-
click a program icon, 
then click Pin this 
program to taskbar 
or Pin to Taskbar. 
To unpin a program 
from the taskbar, 
right-click a program 
icon on the taskbar, 
then click Unpin 
this program from 
taskbar.

QUICK TIP

When you select 
the Desktop icon in 
the Windows Flip 
pop-up window, all 
open windows are 
minimized.

QUICK TIP
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Working with the taskbar

Similar to the Start menu, the taskbar allows you to pin programs or 
fi les to it for easy one-click access. After you pin a program to the task-
bar or open a program, you can right-click the taskbar button to dis-
play a jump list of recently opened fi les for the program. The taskbar 
also provides you with several options for arranging open windows. 
If you want to show all open windows stacked side by side or over-
lapped (known as cascading), you can right-click the taskbar, then 
click the option you want. If you prefer using a mouse, you can drag a 
window to the side of the screen (where the mouse touches the edge) 
to resize it for side-by-side comparison. The taskbar is locked by de-
fault, so it cannot be accidentally resized or moved. You can unlock 

the taskbar to resize and move it. To unlock the taskbar, right-click a 
blank area on the taskbar, then click Lock the taskbar on the shortcut 
menu to deselect the option. You can move the taskbar by dragging it 
to any edge (right, left, top, or bottom) of the desktop. You can also 
change the size of the taskbar in the same way you resize a window 
by dragging its edge. In addition to buttons, you can also show or 
hide toolbars on the taskbar. Right-click a blank area of the taskbar, 
point to Toolbars, then select a toolbar. To create a new toolbar with 
items from a folder, right-click a blank area of the taskbar, point to 
Toolbars, click New toolbar, select the folder you want to use, then 
click Select Folder.

Active

window

Taskbar

buttons

Live thumbnail

FIGURE A-6: Live thumbnail

Stacked window

display

FIGURE A-7: Windows Flip 3D
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UNIT

A
Windows 7

Working with Windows
One of the powerful things about the Windows operating system is that you can open and work with 
more than one window or program at once. That means, however, that the desktop can get cluttered with 
many open windows for the various programs. You can identify a window by its name on the title bar at 
the top of a program window or in the Address bar of a Windows Explorer window, which you also use 
to navigate to different locations on your computer. To organize your desktop, you must sometimes 
change the size of a window or move it to a different location. Each window, no matter what it contains, is 
surrounded by a border that you can drag to resize or move the window. Each window also has three but-
tons in the upper-right corner that allow you to control the size of the window or to close it. In addition to 
using the resizing buttons in a window, you can also drag a window to the top or side of the screen to re-
size it. When you have one or more windows open and you want to display the desktop, you can click the 
Show desktop button (the blank button) located at the right end of the taskbar to minimize all open win-
dows or point to the Show desktop button in Windows Aero to make all open windows transparent to 
quickly see your desktop.  You want to try moving and resizing windows.

1. Point to the Show desktop button  in the lower-right corner of the taskbar to show 
window transparency, click the Show desktop button to show the desktop, then click the 
Show desktop button again to display the Windows Explorer and Control Panel windows 
The Show desktop button gives you two ways to view your desktop. Point to the button to temporarily peek 
at your desktop with transparent windows (in Aero), or click the button to minimize all open windows.

2. Click anywhere in the Windows Explorer window on the desktop
The Windows Explorer window moves in front of the Control Panel window to become active.

3. Click the Minimize button  in the upper-right corner of the Windows Explorer window
The window no longer appears on the desktop, but you can still see a button named Windows Explorer on 
the taskbar. When you minimize a window, you do not close it but merely reduce it to a button on the 
taskbar so that you can work more easily in other windows.

4. Point to the bar at the top of the Control Panel window, click and hold the left mouse 
button, then drag the window to center it on the desktop
The window is relocated. This action is similar to dragging an icon to a new location.

5. Position the pointer on the lower-right corner of the Control Panel window until it 
changes to , then drag the corner up and to the left about two inches
The window is now resized smaller. If you resized it small enough, scroll bars—bars with small arrows at ei-
ther end and a rectangle in the middle—appear on the right and bottom edges of the window, as shown in 
Figure A-8. You can resize windows by dragging any corner or border.

6. Click the Maximize button  in the upper-right corner of the Control Panel window or 
drag the bar at the top of the window to the top of your screen and release the mouse
When you maximize a window, it fi lls the entire screen. When a window is maximized, the Maximize but-
ton is replaced by the Restore Down button.

7. Click the Restore Down button  in the upper-right corner of the Control Panel window
The Restore Down button returns a window to its previous size. The Restore Down button appears only 
when a window is maximized. When you fi nish using a window, you can close it with the Close button.

8. Resize the Control Panel window large enough that the scroll bar doesn’t show
9. Click the Close button  in the upper-right corner of the Control Panel window, then 

click the Windows Explorer button on the taskbar
The Control Panel window closes, and the Windows Explorer window returns to its original size.

STEPS

Right-click the Show 
desktop button, and 
then click Peek at 
desktop to turn off 
peeking.

QUICK TIP

You can also click a 
taskbar button for 
an active window 
to minimize the 
 window.

QUICK TIP

Double-click the bar 
at the top of a win-
dow to switch be-
tween maximizing 
and restoring the 
size of a window.

QUICK TIP

You can also right-
click a taskbar 
button, then click 
Close window to 
close an open 
window.

QUICK TIP
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Using scroll bars

When you cannot see all of the items available in a window, scroll bars 
appear on the right and bottom edges of the window. Scroll bars al-
low you to display the additional contents of the window. The vertical 
scroll bar moves your view up and down through a window; the hori-
zontal scroll bar moves your view from left to right. There are several 
ways you can use the scroll bars. When you need to scroll only a short 
distance, you can use the scroll arrows. When you need to scroll more 
quickly, you can click in the scroll bar on either side of the scroll box 
to move the view up or down one window’s height or left or right 
one window’s width. Dragging the scroll box moves you even more 

quickly to a new part of the window. The scroll box, the box in the 
middle of the scroll bars, indicates your relative position within the 
window. The size of the scroll box indicates the amount of informa-
tion available to scroll. A small scroll box indicates a lot of information, 
whereas a large scroll box indicates a small amount. If you have a 
mouse with a scroll wheel between the left and right buttons, you can 
roll the wheel button to scroll up and down quickly, or click the wheel 
button and move the mouse in any direction. When no scroll bars ap-
pear in a window, it means that all the information fi ts completely in 
the window.

Vertical

scroll bar

Close

button

Up scroll

arrow

Down scroll

arrow

Drag corner

to resize the

window

Show desktop

button

Address bar

Minimize

button

Maximize

button

Scroll box

FIGURE A-8: Window controls in the Control Panel
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UNIT

A
Windows 7

Using Menus, Toolbars, 
and Panes
A menu is a list of commands that you use to accomplish certain tasks, such as when you used the Start 
menu to open a window or program. A command is a directive that provides access to a program’s fea-
tures. Each Windows program has its own set of menus, which are usually located on a menu bar. The menu 
bar organizes commands into menus, or groups of related operations, such as File or Help. To access the 
commands in a menu, you click the name of the menu. You can also carry out some of the most frequently 
used commands by clicking a button on a toolbar. A toolbar contains buttons that display menus, select 
options, or perform commands. For example, the Organize button displays a menu, whereas the Views but-
ton displays a list of options. Note that some buttons have arrows next to them; clicking the button itself 
causes a default action, whereas clicking the arrow next to the button opens a menu. For example, when you 
click the Views button arrow, a list of options appears, and when you click the Views button, the next view in 
the list displays. Other buttons toggle options on and off. For example, when you click the Preview Pane but-
ton on the toolbar, it shows or hides the pane; it works like a light switch in your home.  You want to 
use menus, toolbar buttons, and commands to change how the Windows Explorer window contents appear. 

1. With the Windows Explorer window open, point to the Organize button  on the 
toolbar
When you position the pointer over a button, a description of the action associated with the button appears 
as a ScreenTip. You can use the ScreenTip feature to explore buttons on a toolbar.

2. Click the Organize button on the toolbar
A menu of commands appears. Just like on the Start menu, when an arrow appears on the right side of a 
menu command, pointing to that command opens a submenu.

3. Point to Layout
The Layout submenu appears, displaying commands, as shown in Figure A-9. A pane is a frame within a 
window where you can quickly access commands or display information. The Layout submenu allows you 
to show or hide the menu bar and window panes. On a menu, a check mark identifi es a currently selected 
feature, meaning that the feature is enabled, or turned on. To disable, or turn off the feature, you click 
the command again to remove the check mark. Menu bar is currently disabled. The icons next to the panel 
commands on the Layout submenu indicate the same thing.

4. Click Menu bar on the submenu
A new menu bar appears at the top of the window.

5. Click View on the menu bar
The View menu appears, displaying the View commands. In the View menu, the bullet indicates the current 
view—the way the fi les are displayed in the window. A bullet next to a command indicates that the option 
is enabled. To disable a command with a bullet mark next to it, however, you must select another command 
(within the menu section, separated by gray lines) in its place.

6. Click Status bar to enable it, then click View on the menu bar again
The status bar appears at the bottom of the Windows Explorer window, and Status bar on the View menu 
now has a check mark next to it. A description of the View menu appears in the status bar. See Figure A-10.

7. Click Status bar 
The status bar is turned off.

8. Click the Organize button on the toolbar, point to Layout, then click Menu bar
The menu bar is removed from the window.

9. Click the Close button  in the upper-right corner of the Windows Explorer window
The Windows Explorer window closes.

STEPS

If a command on a 
menu includes a key-
board reference, 
known as a keyboard 
shortcut, you can 
quickly perform the 
action by pressing 
and holding the fi rst 
key, and then press-
ing the second key.

QUICK TIP

If the status bar is 
not visible on your 
screen, the status 
bar was already en-
abled. Click View on 
the menu bar, then 
click Status bar 
again to enable it.

TROUBLE

If you don’t see the 
menu bar, the menu 
bar was already en-
abled. Repeat Steps 
2 through 4.

TROUBLE
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Setting Accessibility for special needs

If you have diffi culty using a mouse or typing, have slightly impaired 
vision, or are deaf or hard of hearing, you can adjust the appearance 
and behavior of Windows 7 to make your computer easier for you to 
use. The Accessibility Wizard takes you step-by-step through a series of 
instructional windows to help you confi gure Windows for your vision, 
hearing, and mobility needs. The Accessibility Wizard also enables you 
to save your settings in a fi le that you can use on another computer. 
To open the Accessibility Wizard, click the Start button on the taskbar, 
click Control Panel, click Ease of Access, then click Ease of Access Center. 
A window opens with verbal instructions for using the Ease of Access 

Center and commands to adjust the way your keyboard, display, and 
mouse function to suit various vision and motor abilities. Some of the 
accessibility tools available include Sticky Keys, which enables simulta-
neous keystrokes while pressing one key at a time; Filter Keys, which 
adjusts the response of your keyboard; Toggle Keys, which emits 
sounds when you press certain locking keys; Sound Sentry, which 
 provides visual warnings for system sounds; Narrator, which instructs 
programs to provide captions; High Contrast, which improves screen 
contrast; and Mouse Keys, which enables the keyboard to perform 
mouse functions.

Toolbar

Views

button

Enabled

option

Arrow

indicates

submenu

Commands

on menu

Preview

Pane button

Submenu

Details

pane

Disabled

option

FIGURE A-9: Organize button in the Libraries window

Bullet

Navigation pane

Check mark

Menu bar

Commands on your

screen might differ

Description of menu

in status bar

FIGURE A-10: View menu open with the status bar visible
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UNIT

A
Windows 7

Using Dialog Boxes
A dialog box is a window that contains options for completing a task. A dialog box opens when you 
choose a button on a toolbar or menu command that is followed by an ellipsis (. . .). The ellipsis on a 
menu command indicates that you must supply more information before the program can carry out the 
command you selected. Dialog boxes open in other situations as well, such as when you open a program 
in the Control Panel. You can also access a dialog box from the notifi cation area on the taskbar. When you 
click an icon in the notifi cation area, such as the date and time, a menu appears with links or commands to 
open a dialog box or Control Panel window. In a dialog box, you specify the options you want using a va-
riety of elements. See Figure A-11 and Table A-3 for some of the typical elements of a dialog box.  
You practice using a dialog box to control your mouse settings.

1. Click the Start button , click Control Panel, click Hardware and Sound, then click 
Mouse under  Devices and Printers
The Mouse Properties dialog box opens, as shown in Figure A-12. The options in this dialog box allow you 
to control the confi guration of the mouse buttons, select the types of pointers that appear, choose the speed 
of the mouse movement on the screen, and specify what type of mouse you are using. Tabs at the top of 
the dialog box separate these options into related categories. The tabs in the dialog box vary depending on 
the mouse installed on the computer.

2. Click the Buttons tab, if necessary
This tab has two or more sections. The contents of the sections vary depending on the type of computer you 
use. For example, a desktop might be different from a laptop. In this case, the fi rst section, Button confi gu-
ration, has options you can select to make the mouse easier to use for a right-handed or left-handed person. 
The second section, Double-click speed, has a slider for you to set how fast the mouse pointer responds to 
double-clicking. The slider lets you specify the degree to which the option is in effect. The third section, 
ClickLock, allows you to highlight or drag without holding the mouse button when you select the 
ClickLock option.

3. In the Double-click speed section, drag the slider to the right to position it about 
 halfway between its current position and the right end of the slider bar
Now the mouse pointer is set to respond to a fast double-click.

4. Double-click the test area to the right of the slider until the graphical icon moves
As you double-click the test area, the folder icon opens or closes. The test area allows you to try out the ad-
justed settings.

5. Click the other tabs in the Mouse Properties dialog box, and examine the available 
 options in each category
The two most common command buttons are OK and Cancel. Clicking OK accepts your changes and closes 
the dialog box; clicking Cancel leaves the original settings intact and closes the dialog box. Many dialog 
boxes, including this one, contain a third command button—Apply. Clicking Apply executes the options 
you selected but keeps the dialog box open so that you can select additional options. 

6. Click Cancel to leave the original settings intact and close the dialog box
7. Click the Close button  in the upper-right corner of the Control Panel window to 

close the window

STEPS

If your dialog 
box differs from 
Figure A-12, read 
through Steps 2–4 
and do not perform 
any actions, then 
continue with Step 5.

TROUBLE

If nothing happens 
when you double-
click the test area, 
try double-clicking 
faster, with less time 
between each click.

TROUBLE

49040_UnitA_pp7.indd   Sec4:1449040_UnitA_pp7.indd   Sec4:14 11/30/09   6:36:40 PM11/30/09   6:36:40 PM

Prop
ert

y o
f C

en
ga

ge
 Le

arn
ing



Windows 15Introducing Windows 7 

W
in

d
o

w
s 7

Option

button

Check box

Up and

down arrows

Command

buttons

Text box

FIGURE A-11: Dialog box elements

Slider

Test area

Tabs; yours

might differ

FIGURE A-12: Mouse Properties dialog box

TABLE A-3: Typical items in a dialog box

Check box A square box that turns an option on when the box is checked and off when the box is blank

Command button A rectangular button with the name of the command on it; it carries out a command in a dialog box

List box A box containing a list of items; to choose an item, click the list arrow, then click the desired item

Option button A small circle that selects a single dialog box option (you cannot check more than one option button in a group)

Up and down arrows A box with two arrows and a text box you can scroll through to choose from numerical increments or 
 type a number

Slider A shape that you drag to set the degree to which an option is in effect

Tab A place where related options are organized; similar to tabs on fi le folders

Text box A box in which you type text

item description
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UNIT

A
Windows 7

Using Windows Help 
and Support
When you have a question about how to do something in Windows 7, you can usually fi nd the answer with 
a few clicks of your mouse. Microsoft Help and Support is a complete resource of information, training, 
and support to help you learn and use Windows 7. Help and Support is like a book stored on your computer 
with additional links to the Internet, complete with a search feature, and a table of contents to make fi nding 
information easier. If you have an Internet connection, you can get online help from a support professional 
at Microsoft or from other users on the Windows newsgroup (an electronic forum where people share infor-
mation), or invite a friend with Windows to chat with you, view your screen, and work on your computer to 
provide remote support.  You want to use Help and Support to learn more about Windows 7.

1. Click the Start button  on the taskbar, then click Help and Support
The Windows Help and Support window opens with a list of Help and Support categories, as shown in Fig-
ure A-13. Help windows always appear on top of the currently active window, so you can see Help topics 
while you work. You can fi nd answers from the main categories (How to get started with your computer, 
Learn about Windows Basics, or Browse Help topics), or go online to the Microsoft Web site to get more in-
formation, downloads, and ideas. If you need additional help, you can display more support options to ask 
others online for help.

2. Click in the Search box, type help, then press [Enter]
A list of the best results possible displays. See Figure A-14. To display more results, scroll to the bottom of 
the window, and then click the more results link. When you point to a Help category or a search result, the 
pointer changes to , and the Help text becomes underlined to indicate that more information is available 
by clicking. A single-click opens the Help category or topic. This is similar to the way selecting a hyperlink 
on the Internet works.

3. In the results list, click Getting help
The Help topic appears in the window. Read the information on getting help.

4. Click the Help and Support home button  on the toolbar at the top of the Windows 
Help and Support window
The main Help and Support window appears again. Now you will display a search pane with more topics.

5. Click Browse Help topics to open the list of main Help topics, click Getting started, then 
click Shutting down
Help topics in the Shutting down category appear. The list of contents organizes the online Help topics and 
allows you to browse your way around the Help topics you want to view.

6. Click Turning off your computer properly
The Help topic appears in the window. You can move back and forth between Help topics you have already 
visited by clicking the Back button and the Forward button on the toolbar.

7. Click the Back button  on the Help and Support toolbar to return to the previous 
Help screen
Help topics in the Shutting down category appear.

8. Click the All Help link below the Help and Support toolbar to return to the main Help 
topic list

9. Click the Close button  in the upper-right corner of the Help and Support window
The Help and Support window closes.

STEPS

If your dialog box 
differs from Figure 
A-13, click the lower-
right button, then 
click Get online Help.

TROUBLE

To get help on a 
specifi c program, 
you can click Help 
on the program’s 
menu bar or click 
the Help button on 
the toolbar.

QUICK TIP

To print a Help topic, 
click the Print button 

 on the toolbar 
at the top of the 
Windows Help and 
Support window.

QUICK TIP

To receive help in a 
dialog box or win-
dow, click the Help 
button  in the 
upper-right corner of 
the dialog box or 
window. The Help 
and Support window 
opens, displaying 
Help information re-
lated to the options 
in that dialog box.

QUICK TIP
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Getting help online

If you need additional help and have an Internet connection, you can 
use Windows Help and Support to get online help from a support pro-
fessional at Microsoft or from other users in Windows communities, or 
you can invite a friend to chat with you, view your screen, and work on 
your computer to provide remote support. To get help from a friend or 
offer help to a friend, you use Windows Remote Assistance, which con-
nects two computers over the Internet so that one person can help 

troubleshoot or fi x problems on the other person’s computer. While the 
computers are connected, the person providing assistance can view the 
other person’s screen or take control of the computer to perform a fi x. 
To do this, in Windows Help and Support, click the Ask button on the 
toolbar at the top of the Windows Help and Support window, click 
 Windows Remote Assistance under Ask a person for help, and follow 
the step-by-step instructions provided.

Search box

Help

categories

Help toolbar

Back and

Forward buttons

Online

information

Click to set

Help settings

FIGURE A-13: Windows Help and Support

Search text

Help topic

search results;

your results

may vary

FIGURE A-14: Help topic
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UNIT

A
Windows 7

Shutting Down the Computer
When you fi nish working on your computer, you need to make sure to turn off, or shut down, your com-
puter properly. This involves several steps: saving and closing all open fi les, closing all open windows, exit-
ing all running programs, shutting down Windows itself, and, fi nally, turning off the computer. Shutting 
down your computer makes sure Windows and all its related programs are properly closed; this avoids 
potential problems starting and working with Windows in the future. If you turn off the computer by push-
ing the power switch while Windows or other programs are running, you could lose important data. If a 
program is still open when you instruct Windows to shut down, you will be prompted to save the fi le and 
close the program before the shut-down process continues.  You shut down your computer now.

1. If any windows or programs are open on your screen, click the Close button  in the 
upper-right corner of each window

2. Click the Start button  on the taskbar, then point to the arrow  next to the 
Power button
A submenu appears, displaying several options for turning off your computer, as shown in Figure A-15. See 
Table A-4 for a description of each option. The Power button (set by default to Shut down) provides easy ac-
cess to your preferred shutdown option. Depending on your Windows settings, your shutdown options 
might be different.

3. If you are working in a lab, click the Windows desktop to cancel the task; if you are 
working on your own machine or if your instructor tells you to shut down Windows, 
click the Shut down button or menu option to exit Windows and shut down your 
 computer

4. If you see the message “It’s now safe to turn off your computer,” turn off your computer 
and monitor
Some computers power off automatically, so you might not see this message.

STEPS

To prevent other 
 users from using 
your computer, you 
can press  [L] to 
lock the computer 
and return to the 
Welcome screen. To 
 unlock, move the 
mouse and log on at 
the Welcome screen.

QUICK TIP

TABLE A-4: Shut down options

Switch Maintains your session and changes users When you want to continue working with Windows, yet allow another user to
user  access another Windows session

Log off Saves and leaves your session to disk and When you want to stop working with Windows, yet allow another user to access
 changes users another Windows session

Lock Maintains your session, while restricting When you want to stop working with Windows and you want to keep others
 access to Windows  from using Windows

Restart Restarts the computer and reloads Windows When you want to restart the computer and begin working with Windows again
  (when your programs might have frozen or stopped working)

Sleep Maintains your session, keeping the When you want to stop working with Windows for a few moments and conserve
 computer running on low power power (ideal for a laptop or portable computer); available when a power
  scheme is selected in Power Options (in the  Control Panel)

Hibernate Saves your session to disk so that you can When you want to stop working with Windows for a while and start working
 safely turn off power; restores your session again later; available when the Power Options setting (in the Control Panel)
 the next time you start Windows is turned on

Shut down Prepares the computer to be turned off When you fi nish working with Windows and you want to shut off your computer

option function when to use it

If you have a mobile 
PC, set Power Op-
tions in the Control 
Panel to turn off 
your computer or 
put it to sleep by 
closing the lid.

QUICK TIP
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Working on a computer set up for multiple users

Many users may use the same computer, in which case each user 
has his or her own Windows identity, allowing them to keep their 
fi les completely private and customize the operating system with 
their own preferences. Windows manages these separate identities 
by giving each user a unique username and password. You set up 
user accounts during Windows 7 installation or by using User Ac-
counts in the Control Panel, as shown in Figure A-16. When Win-
dows starts, a Welcome screen appears, displaying user accounts. 
When a user selects an account and types a password (if necessary), 
Windows starts with that user’s confi guration settings and network 
permissions. When you’re done using the computer, yet you want to 
leave it on for another person to use, you can choose the Switch 
user or Log off command from the Start menu. The Switch user 
command allows you to switch between users quickly without hav-
ing to save your current settings, so you can switch back and 
 continue working. The Log off command saves your current settings 
and exits you from Windows.

FIGURE A-16

Shut down

menu

Power button;

displays

Shut down

by default

Arrow that

displays the

Shut down

menu

FIGURE A-15: Shut down menu
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